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Introduction 

Following the release of the E+PLC Phase 5 (CODESYS V3.5 SP17) software, it is necessary to make various 
updates to existing E+PLC Phase 4 projects and/or devices, in order for it to be used with Phase 5 software and 
firmware.  
 
This document explains the necessary steps required to migrate from previous Phase 4 (CODESYS V3.5 SP15) to 
Phase 5 (CODESYS V3.5 SP17). 
 
Note: It is assumed that the application, existing project to be migrated is in working order, message free and builds 
successfully 

Before Upgrading 

Take a backup of the project as a precaution. 
Take copies of the network.ini file and fw4.cfg files for reference. This is so that the IP address details and the firewall 
setting details can be checked after the upgrade. 
This can be done via the IDE or for phase 4 E+PLC400 devices, by copying the files directly from the SD card. 
 
Refer to the existing Phase 4 help if required. 
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Safety Notes 

Project Migration - Control scheme 

1. The application of this product requires expertise in the design and programming of control 
systems. Only persons with such expertise must be allowed to program, install, alter and 
commission this product. 
 

2. The designer of any control scheme must consider the potential failure modes of control paths 
and, for certain critical control functions, provide a means to achieve a safe state during and after 
a path failure. 
 

3. Separate or redundant control paths must be provided for critical control functions. 
 

4. System control paths may include communication links. Consideration must be given to the 
implications of unanticipated transmission delays or interruptions.  
 

5. To help minimize any potential loss of control or controller status when communicating across a 
network or being controlled via a third-party master (i.e. another controller, PLC or HMI) ensure 
all system hardware, software, network design, configuration and cybersecurity robustness have 
been correctly configured, commissioned and approved for operation. 
 

6. Each implementation of this equipment must be individually and thoroughly tested for correct 
operation before being placed into service.  
 

7. Do not use or implement a controller configuration (control strategy) into service without ensuring 
the configuration has completed all operational tests, been commissioned and approved for 
service. 
 

8. It is the responsibility of the person commissioning the controller to ensure the configuration is 
correct. 
 

9. During commissioning ensure all operating states and potential fault conditions are carefully 
tested. 
 

10. At commissioning ensure that under maximum load condition, the ambient temperature of the 
product will not exceed the limit stated in the User Guide. 
 

 
 
Please also refer to and comply with the safety instructions contained within the relevant User Guides listed below, at 
Eurotherm > Home > Downloads; 

• E+PLC400 Hardware Reference Guide (HA031923) 
 
 
 

  

https://www.eurotherm.com/eurotherm-downloads/
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E+PLC Phase 5 updates 

Important Note: The order of the upgrade is important. Please follow the procedure in the correct order. 
 

Device Feature Updates 

For details of the Phase 5 features, please refer to the following sales alerts: 
• TB1577 - E+PLC Phase 5 Firmware and Software Release 

 

E+PLC Software (CODESYS IDE) 

Firstly, install Phase 5 (CODESYS V3.5 SP17) of E+PLC software on to the computer. (This can be installed 
alongside an existing version if required). 
The E+PLC Software is available to download from the E+PLC Customer Share box folders, which can be found here: 

 
Once you are in the folder, there is a sub-folder entitled PC Software Tools, then E+PLC IDE (Codesys) 
The .iso and .exe files are available for download from here. 
If you do not have the rights to access the folder, please contact Global Support. 
 

E+PLC device 

Next update the firmware of the E+PLC Device refer to the document titled "Application note - Firmware update to 
phase 5" for details of upgrading the E+PLC400. 
This is in the same E+PLC Customer Share box folder referenced previously. 
 

E+PLC Customer Share 
https://schneider-electric.box.com/s/egsqu6kypcepulje4c2c 

 
  

 

https://schneider-electric.box.com/s/egsqu6kypcepulje4c2c
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E+HMI150 

There is no requirement to update the E+HMI150 software for Phase 5. However, please be aware of a new 
requirement to revise the E+HMI150 Config file for Phase 5, further details can be found here Visualization 
considerations – loss of communication events.  
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E+PLC Software (CODESYS IDE Phase 5) 

Migrating a Project 

After upgrading the software and firmware, open phase 5 CODESYS V3.5 SP17 application. 
Open the project application that needs migrating from phase 4 to phase 5. Depending on the Project, the following 
aspects may need to be updated. 
 

Note: Some of the images used in this guide do not relate directly to the phase 5 file versions; the text takes 
precedence where versions are mentioned. 

Libraries 
Upon opening the project, the following messages may appear. 
For all of them select Yes to overwrite. 
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Press OK.   
The project will continue to load, depending on the size of the project this may take approximately 5 minutes. 
The libraries listed will vary from project to project, as it depends on what is being used. 
Once the project has loaded, the following dialog will appear. 
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Project Environment 
Select “Set all to newest” and you will get a confirmation dialog detailing which libraries are being upgraded. 

 
Click the Set All to Newest  
The following message appears. 
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Confirmation dialog: Set All to Newest  

 
Click OK. 
Press OK, which will take you back to the previous dialog box, but with the action updated to show that the libraries 
will be updated to the latest version.  
Click OK again. 
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The following type of message may appear, depending on what has been used in the project: 
 

 
 
Click OK - the following message appears. 

 
 
Click Yes, and then the project will be ready to modify.  
If there are any messages about the initialization of variables, click Yes to these. 

 
Note: If there are any Library Manager messages in the build output window, ignore these at this stage, they 
will be resolved later in the process. 
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Depending on whether the project contains function blocks the following message about auto data flow may appear. 
Click configure if required, however the data flow should not change because of migrating from phase 4 to phase 5. 
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Project Device Descriptors 
The next step is to update the device descriptors for PLC, backplane, and all I/O modules.  
It is recommended, at this stage to connect to the E+PLC Device, to do this the E+PLC Device must be powered up 
and connected by Ethernet to the computer. 
Note: It is assumed that the E+PLC device has already had the firmware upgraded to phase 5. 
 
Connecting to an E+PLC device 
Initial connection will require the following; 

• Default Passwords for initial connection 
• Create and enter a new mandatory Administrator password for the Device. 

 
Please refer to the following topics in the CODESYS Online Help: 

• Home > Setting up E+PLC400 hardware > Initial connection & connecting to E+PLC400. 
 
 
Update Descriptors 
 
Right click on the Device name on the left tree and choose Update Device – see below figure. 
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The following dialog will appear, select the relevant device, then click update in the bottom right. 

 

 
 

 

 

 

 

 

 

 

 

Processor_IO, Backplane type, Associated and Local I/O modules 
Next, the Processor_IO, and Device backplane objects (for E+PLC400) and all associated I/O modules require 
updating using the same method.  (For example, you do not need to close the above box, simply click on the next 
device within the tree view. If you do close it, then right click and choose update device in the next device).  
Click on Backplane to update. 
Expand the backplane (click the +) and do the same for each I/O module. 
Modbus TCP 
If the application uses Modbus TCP, the Ethernet adapter needs to be updated. 
Right click the Ethernet Adapter and click on “Update Device”. 
Expand Fieldbusses, locate Ethernet Adapter and select E+PLC400.   
Press “Update Device” then “Close”. 
Data Recording 
The Eurotherm Data Recording element within the tree view will also need updating, as will each be recording group. 
Follow the same procedure as above. 
Upon completion of updates, Close the update window.  
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Visualizations 
As a result of the upgrade, some visualization objects have been updated. 
Go to Project > Project Settings > Visualization Profile.  If they are required, ensure that the three visualization 
extensions below are set to the most recent version. 

 

Figure 1 Available Visualization Profile 

 

Click OK, and the visualization profiles will be updated. 
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Library name space 
At this point, the next step is to complete a Build. 
It is expected that the Build will not complete successfully at this stage, but it makes it easier for the updating of 
libraries. If any information boxes appear, click OK to continue. 

 
Upon compilation, additional messages relating to libraries are likely to appear. This is because the program may 
have not automatically updated all libraries, so some may need manual intervention. 
To do this, open the Library Manager from within the application.  
Click on the placeholders’ tab, then look for any libraries which have lost their placeholder information or are 
highlighted in bold. 
Double click on the library column, and choose 1.4.0.x if it is available, otherwise choose ‘Other Library’. If a library in 
bold is already at 1.4.0.x, then no action is necessary for that library. 
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Modified libraries will appear in bold. 
 

There is a Download Missing Libraries tab (A) which can be used if necessary. 

 

 

  

A 
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Further to this, when a build is attempted, there may be a few messages, similar to the following: 

 
 

This indicates that some libraries have not been updated successfully as part of the automated process and may need 
to be deleted and re-added manually. 
The messages will usually give an indication of which libraries are the cause of the issues. A common issue is that two 
versions of the same library are present after the upgrade.  

Note: The E+PLC application upgrade process installs the new libraries but does not remove the old ones if they are 
a sub-library of another element).  Also, there may occasionally be libraries which need to be manually added. 
One example of this is the VisuElems library, search in the messages for undeclared elements and identify 
from the libraries which libraries may be missing. 

 
Project - Clean, Build and Load 
Following the library updates, a Clean (Build -> Clean) is recommended. 
Now build the project and it should compile successfully. Download and run the migrated project. 

Note: If the project was opened from an archive it will need to have had the libraries included in the archive, 
otherwise they may need to be manually added again. 
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Further Security Information 

Recovery Procedure > Restore non-responsive Device 
Note: Using Reset Origin Device will clear and reset the password. 

 

Encryption and Certificates 

Note: Further information regarding certificates can be found in the Codesys help. 
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Encrypted Communications 
Notice the Comms line on display in the Communication Settings dialog, is shown with a yellow highlight, whereas in 
previous versions it was shown in black. 
When yellow, it indicates communications are encrypted, if in black no encryption is in operation. (By default, 
Encrypted comms is set on). 
The setting can be seen by selecting the Device tab on the Communication Settings dialog. 
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Project Settings  

Security 
After the migration is complete, Security settings for the Project can be altered if required by: - 
Project - Settings - Security. 
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Integrity check 

 

Encryption 
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Device Certificates 
E+PLC Device Certificates are used on connection and can be imported and exported. 
There are folders in the E+PLC Device's filing system. New devices are shipped with a default self-generated 
certificate. 
Devices that are being updated will need to re-establish the default certificate, as well a device that is renamed, see 
E+PLC Device name change - Generate Device certificate. 
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To see User Profile and Certificate Selection details. 

 

 
E+PLC Device name change - Generate Device certificate 
If the user changes the E+PLC Device Name, encrypted communications will stop working until a new self-signed 
certificate is generated and applied. (This does not affect or influence non-encrypted communications).  
 
To create self-signed certificate, after changing the E+PLC device name complete the following: 
 

1. Using CODESYS IDE, create or open a test project. 
2. Select Device > Communication Settings > Device, disable encrypted communication. 
3. Select Scan Network and connect to the relevant E+PLC device. 
4. Select Device > PLC Shell, execute the command cert-genselfsigned. 
5. Wait for the command to complete. 
6. Select Device > PLC Shell execute the command cert-getapplist. 

 
Verify that the certificates are generated successfully. 
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Known Issues: 

E+HMI150 

Visualization considerations – loss of communication events 
A behavior has been observed that the E+HMI150 does not reconnect communications with the E+PLC400 
combination PLC if communication has been lost for 30 seconds or more. If the loss in communications is short (less 
than ~30 seconds) then the remote target visu reconnects and works as expected.  
If communication is lost for longer than this, then the panel display freezes and requires a power-cycle to recover. 
If communication is restored before any Remote target visu message window appears then the HMI panel will resume 
operation and display the CODESYS application visualization.  
If the Remote CODESYS message window appears, it will be necessary to power cycle the E+HMI150 once 
communication between the panel and E+PLC400 are restored. 
 

Note: Without a power-cycle of the E+HMI150, the panel remains frozen showing the CODESYS Remote target visu 
message window. 

A loss in communication event could be the disconnection of the cable between the E+HMI150 and the E+PLC400 or 
power cycling the E+PLC400. 
 

CODESYS Remote target visu message window - enable 
The CODESYsControl.cfg must be exported from the HMI panel, refer to section 4 HA032099ENG_2_E+HMI150 
Configuration guide. 

 
Edit CODESYSControl.cfg and add (at top of file) following lines: 

[ComponentManager] 
WindowHided=0 
[CmpVisuHandlerRemote] 
Communication.TcpAddressDest=192.168.111.222 
Communication.TcpAddressDestPort=-1 
;Communication.AddressDest=  
;Communication.PlcNameDest=N01H0001  
VisuClient.VisuAppName=Application  
VisuClient.StartVisu=Visualization  
;VisuClient.BestFit=1  
;Credentials.UserName=  
;Credentials.Password=  
;VisuClient.AntiAliasing=  
[SysFile]  
FilePath.1=\Flash\RemoteVisu  
[CmpBitmapPool] 
;BitMapPath= 

 
Refer to section 4 of HA032099ENG_2_E+HMI150 Configuration guide to import the revised configuration and 
continue following the remaining instructions. 
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Once complete should you get a loss in comms for more than 30 seconds the Remote CODESYS message window 
display, it will be necessary to power cycle the E+HMI150. 
 
 

Time Zones update 

There are three choices of libraries for handling of time zones: 
(1) CAA DTUtil Extern 
(2) CAA Real Time Clock Extern 
(3) SysTimeRTC 

 
The Eurotherm documentation recommends using the CAA DTUtil library. Both the CAA DTUtil and CAA 
Real Time Clock work as expected. 
 
However, when using SysTimeRTC, some issues have been identified in the CODESYS 3.5 SP17 version. 
 

(1) The SysTimeRtcConvertHighResToLocal function applies a double offset so if the time zone is +2 
hours, this function actually reports time as +4 hours 
 

(2) The iBias setting which defines the time zone offset use opposite sign to other two libraries (this 
SysTimeRTC does document the behavior so the library is working as documented, but it is different 
to the other two) 

(3) Where CAA DTUtil and CAA Real Time Clock are interchangeable - as in set time zone updates a 
common setting that both libraries use. Read/Write time zones with either library is fine. Writes to 
time zone using these two libraries is reflected in reads on SysTimeRTC BUT writes to time zone 
using SysTimeRTC are not fed back to the common setting and therefore CAA DTUtil and CAA Real 
Time Clock do not show the new setting. 

 
Since the Eurotherm recommendation is not to use the above library, it is not expected that the above will 
cause application issues, however, this information is being included for completeness. 
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References WSTRING & STRING behavior change 

A change in behavior has been identified within CODESYS 3.5 SP17 when using multi-line STRING and WSTRING 
variables. 
For example, with the following declaration:  

wsTest : STRING := "ABC 
DEF" 

Within the previous CODESYS release, wsTest had both a carriage return and a line feed between ABC and DEF. 
With the latest release, wsTest only has a line feed between ABC and DEF.  
 
Whilst this shouldn’t change application behavior, it is worth being aware of this update in case there could be any 
unforeseen impact. 
 
Package Manager Unhandled Exception message, when uninstalling E+PLC 
packages 

Unhandled exceptions are raised during E+PLC package uninstall using CODESYS Package Manager resulting in a 
blocking of the uninstall procedure. 
 
When the user clicks Tools=>Package Manager, a dialog with all installed packages is listed.  
If the user then selects a package that contains visualisation extensions (This includes E+PLC, E+PLC HeatTreatment 
and E+PLC Setpoint Programmer libraries) then the error dialog is displayed as shown below.  
 
The user should click "continue" to cancel the exception dialog. If the user clicks "quit" then the CODESYS IDE will 
close completely. 
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Device User Management considerations 

E+PLC400 Phase 4 already configured 
If device user management is configured within a Phase 4 installation, and the E+PLC400 firmware is upgraded to 
Phase 5, then the device user management is preserved across upgrade (as would be expected). 
However, if the access rights from Phase 4 are not configured, for example see 'X' for user mySP15group_A below, 
then these would need to be explicitly set in the same way as creating new device user management. 

 

 
 

E+PLC400 device (new) 
Any new device management group (users) created will require the access rights to set explicitly, as the default 
setting is ‘X’. 
Once you have followed the Add Device User instructions and created a new Administrator user you will be able to 
view and edit the user management and each User groups access rights (only groups, not individual users). 
 
For further information please refer to CODESYS Online Help (Help > Menu), specifically the following; 

• CODESYS Development System > Downloading an Application to the PLC > Handling of Device User 
management; 

 General information about device user management 
 First-time login on the controller in order to edit or view its user management 
 Setting up a new user in the user management of the controller 
 Changing of access rights to controller objects in the user management of the controller 

 CODESYS Development System > Reference, User Interface > Objects > Object 'Device' and Generic Device 
Editor > Tab 'Access Rights'; 

 Overview of the objects 
 

  

ms-its:C:%5CProgram%20Files%20(x86)%5CEurotherm%5CE+PLC%201.4.0.0%5CCODESYS%5COnline%20Help%5Cen%5Ccodesys.chm::/_cds_f_development_system_introduction.htm
ms-its:C:%5CProgram%20Files%20(x86)%5CEurotherm%5CE+PLC%201.4.0.0%5CCODESYS%5COnline%20Help%5Cen%5Ccodesys.chm::/_cds_struct_application_transfer_to_plc.htm
ms-its:C:%5CProgram%20Files%20(x86)%5CEurotherm%5CE+PLC%201.4.0.0%5CCODESYS%5COnline%20Help%5Cen%5Ccodesys.chm::/_cds_handling_user_management_on_plc.htm
ms-its:C:%5CProgram%20Files%20(x86)%5CEurotherm%5CE+PLC%201.4.0.0%5CCODESYS%5COnline%20Help%5Cen%5Ccodesys.chm::/_cds_handling_user_management_on_plc.htm
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OPC Server – Manual Installation Required 

By default, the CODESYS OPC Server is no longer installed by default as part of the E+PLC tools. 
The updated software ISO image contains additional files for installing the CODESYS OPC Server. 
 
If the OPC Server functionality is required, then this should be installed after the E+PLC tools are installed. 

  
 

1. Run CODESYS OPC DA Server 3.7.17.20.exe 
     Use the custom install option, and only install CODESYS OPC DA Server feature. 
     DO NOT INSTALL CODESYS Gateway or CODESYS Gateway 2.3. 

 

  
 

2. Copy WinCoDeSysOPC.exe from the ISO image (highlighted above) and overwrite the installed version. 
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